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1Touchpad Computer Application-IX (Answer Key)

Unit-1: Basics of Information Technology

	   Basics of Information Technology

Exercise

A.	 1.	 iii	 2. iii	 3. iv	 4. ii  
	 5. iii	 6. ii
B.	 1.	 Douglas Engelbart	 2. Nine
	 3.	 120 mm		  4. Arithmetic Logic Unit, Control Unit, Memory Unit
	 5.	 Magnetic
C.	 1.	 i. �Both Assertion (A) and Reason (R) are true and Reason (R) is the correct explanation of 

Assertion (A).
	 2.	 iv. Assertion (A) is false, but Reason (R) is true.

SECTION B
(Subjective Type Questions)

A.	 1.	 Data	 2. Platter	 3. Kernel	 4. Nibble	 5. Pixels 
B.	 1.	 i. �Mobile application is specifically meant for use on handheld wireless computing devices 

such as smartphones and tablets.
	 	 ii. �Kernel is the core part of an OS, that does all the major activities (such as memory allocation, 

CPU time, scheduling, etc.) for the operating system.
	 	 iii. �File System is the basic structure and concise format to arrange the set of information 

with their names.
	 	 iv. �A device driver is a form of software that enables a hardware device to be compatible 

with the computer.
	 	 v. �These devices are capable of scanning handprints, fingerprints, retinal information, facial 

features etc.

1.
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	 	 vi. A Barcode reader is a popular scanning device that reads the bar codes.
	 	 vii. �Chat sites is a feature of Internet that enables instantaneous transmission of messages 

from the sender to receiver on Internet.
	 	 viii. �Social networking refers to a network of several people interacting through computing 

device around the world on the Internet.
	 2.	 i. New Technology File System 
	 	 ii. Light Emitting Diode
	 	 iii. Magnetic Ink Character Reader
	 	 iv. Power On Self-Test
	 	 v. Computer Aided Design
	 	 vi. Desktop Publishing
	 	 vii. Extended File System 
	 	 viii. File Allocation Table
	 	 ix. Wireless Fidelity
	 	 x. Worldwide Interoperability for Microwave Access
	 	 xi. Radio Frequency
	 3.	 BIOS is stored in ROM and it operates when the computer is switched ON.
	 4.	 Wi-Fi, Bluetooth, Zigbee, WiMAX.
	 5.	� No, a computer cannot make decisions on its own. It needs predefined instructions or 

programs to perform any tasks or make decisions.
	 6.	� RAM (Random Access Memory) is volatile because it loses all stored data when the power 

supply is turned off.
	 7.	� Cache memory stores frequently accessed data and instructions to provide faster access, 

reducing the time needed to retrieve data from main memory.
	 8.	� By installing antivirus software, keeping the operating system updated, avoiding downloading 

suspicious files, and regularly scanning for malware.
	 9.	 i. �Impact printers print by physically striking a surface (e.g., dot matrix printers), while non-

impact printers use heat, ink, or lasers to print (e.g., inkjet, laser printers).
	 	 ii. �Bluetooth is used for short-range wireless communication between devices, while Wi-Fi 

provides internet access over a larger area.
	 	 iii. �Hardware refers to the physical components of a computer, while software consists of 

programs or applications that run on the hardware.
	 	 iv. �RAM (Random Access Memory) is temporary and volatile, used for active tasks, while 

ROM (Read-Only Memory) is permanent, non-volatile memory that stores critical system 
instructions.
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C.	 1.	� The CPU consists of three functional elements: The Arithmetic Logic Unit (ALU), which 
performs calculations and logical operations; the Control Unit (CU), which directs operations 
and manages data flow; and the Memory Unit (MU), which stores instructions, data, and 
intermediate results. 

	 2.	� Software refers to the programs and applications that run on a computer. It can be categorized 
into:

	 	 • � Application Software: Programs designed for specific tasks (e.g., MS Word, MS Excel).
	 	 • � System Software: Software that helps the computer operate and manages resources (e.g., 

Windows, macOS).
	 	 • � Utility Software: Tools to perform tasks like virus scanning and file management (e.g., 

WinRAR, antivirus software).
	 3.	� Networking refers to connecting computers and other devices to share resources and 

information. Advantages include easier file sharing, resource sharing (like printers), remote 
access, and reduced costs for data transmission.

	 4.	� Characteristics of computers include speed (rapid processing of data), accuracy (precise 
calculations), automation (tasks performed without human intervention), storage capacity 
(large amounts of data can be stored), and versatility (ability to perform different tasks).

	 5.	 Common types of guided media include:
	 	 • � Twisted Pair Cable: Used in telecommunication, consists of pairs of wires twisted together 

to reduce interference.
	 	 • � Coaxial Cable: A cable with a central conductor, insulating layer, and outer shield, used 

for data transmission over longer distances.
	 	 • � Fiber Optic Cable: Uses light to transmit data, providing high-speed and long-distance 

communication with minimal signal loss.
	 6.	� The components of multimedia include text, graphics, animation, audio, and video, which 

are used together to create interactive and engaging content.
D.	 1.	� She should use Accounting Management Software, which is designed to automate and 

manage financial tasks.
	 2.	� Rahul is using a Compiler, which translates the entire program into machine code in one 

go.
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SECTION C 
(Case-based/Passage-based Type Questions)

	 1.	 i	 2. iv	 3. iii

Unit-2: Cyber Safety

	   Cyber Safety

Exercise

A.	 1.	 iii	 2. ii	 3. i	 4. i	 5. ii
	 6.	 iii	 7. ii	 8. ii
B.	 1.	 Internet	 2. Antivirus, Antispyware	 3. Cookies	 4. Password
	 5.	 Privacy	 6. CERT-In	 7. Spammer	 8. Booting	 9. Keylogger 
C. 	 1.	 iii – Assertion is true, but Reason is false.
	 2.	 ii – Both are true but Reason is not the correct explanation.
	 3.	 i – Both are true and Reason is the correct explanation.
	 4.	 iv – Assertion is false, but Reason is true.

SECTION B 
(Subjective Type Questions)

A.	 1.	 Firewall	 2. Password	 3. Cyber Stalking
	 4.	 Virus, Worm, Trojan Horse, Spyware	 5. Antivirus	 6. Quick Heal 
B.	 1.	 i. Computer Emergency Response Team - India
	 	 ii. Law Enforcement Agency
	 	 iii. Master Boot Record
	 	 iv. Blue Screen of Death
	 2.	 i. Privacy: Control over one’s personal data and how it is shared or viewed online.
	 	 ii. �Secure Transaction: Use of HTTPS, digital certificates, and secure websites to protect user 

data online.
	 	 iii. Spyware: Software that secretly gathers user data without consent.
	 	 iv. �Password: A key consisting of characters that ensures only authorised users access a 

system.

2.
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	 3.	 Some measures to reduce cyber-attacks are:
	 	 • Do not share personal information
	 	 • Use strong passwords
	 	 • Avoid unsecured Wi-Fi
	 	 • Use antivirus/firewalls
	 	 • Update software regularly
	 	 • Avoid unknown links/emails
	 4.	 Firewall is a security system that filters network traffic and blocks unauthorised access.
	 5.	 Cyber bullying, cyber stalking and identity theft are various categories of cybercrime.
	 6.	 Malware is malicious software designed to harm or exploit systems.
	 7.	 Virus is a self-replicating malware that infects files or programs.
	 8.	� A worm is a type of malware that replicates to slow down systems and often spreads via 

networks.
	 9.	� Trojans are infectious programs which silently infect the computer and corrupt the files of 

a host computer.
	 10.	� Spam refers to an unwanted and unsolicited message which is received in the inbox of a 

person’s e-mail account or in newsgroups.
	 11.	� A program file infecting virus is a type of malware that infects the executable files of a 

program with the intention of causing permanent damage or making the program useless.
	 12.	 i. Morris Worm, Mydoom
	 	 ii. Infostealer.Kronbank, Linux.Wifatch
	 	 iii. BrO_AcT, Byte Bandit
	 	 iv. Michelangelo, Polyboot.B
	 	 v. McAfee, Quick Heal
	 	 vi. Windows, Linux
	 	 vii. aniKR@87@18, Esd{@37
	 	 viii. Trojan Horse, Spyware
C.	 1.	 •  Don’t share personal information
	 	 •  Use secure websites (HTTPS)
	 	 •  Avoid public Wi-Fi
	 	 •  Don’t install from unknown sources
	 	 •  Update antivirus regularly
	 	 •  Use VPN and strong passwords
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	 2.	 Following are the tips for creating non-guessable password:
	 	 •  At least 8 characters
	 	 •  Use mix of upper/lower case, numbers, symbols
	 	 •  Avoid repetition or predictable sequences
	 	 •  Don’t use personal info
	 	 •  Change passwords regularly
	 3.	 Cyber security is a measure to prevent or safeguard from cybercrimes or cyber attacks.
	 4.	� Confidentiality refers to keep the data or information secret and allowing only authorised 

people to access the information.
	 	 The following data generally come under confidential category: 
	 	 •  Medical history or records 
	 	 •  Date of birth 
	 	 •  Contact details 
	 	 •  Income status 
	 	 •  Itinerary, celebration photographs of family or friends 
	 5.	 •  Inform stalker to stop
	 	 •  Save threatening messages
	 	 •  Report to ISP
	 	 •  File complaint with LEA
	 6.	 CERT-In
	 	 Following are the functions CERT-In: 
	 	 •  Collects and analyses cyber incident data
	 	 •  Issues alerts and advisories
	 	 •  Provides emergency handling and technical analysis
	 7.	 •  Email spamming
	 	 •  Security breaches
	 	 •  Malware attacks
	 	 •  Data modifications
	 	 •  Unauthorised access
	 8.	� There are certain symptoms that hint that a computer has been infected by malware or virus, 

like:
	 	 •  Slowdown 
	 	 •  Pop-ups 
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	 	 •  Crash 
	 	 •  Running Out of Storage Space 
	 	 •  Loss of File 
	 	 •  Unusual activity of messages or programs 
	 	 •  Unusual Network Activity
	 9.	� A spyware generally infects a computer system by getting transmitted through Internet, 

websites, webpages, e-mails or through network of computers.
	 	 To prevent the attacks of spyware:
	 	 •  Use anti-spyware (software)
	 	 •  Avoid exploring the error dialogs on Internet
	 	 •  Avoid using free deal offers on Internet
	 	 •  Enable firewall protection and use browser security features
	 	 •  Be sure of the authenticity of a desired program before installing it in your computer
	 10.	 i. To report incidents to cert-in, follow these steps:
	 	 Step 1 Visit the website www.cert-in.org.in.
	 	 Step 2 Click on the Incident Reporting link. 
	 	 Step 3 �Double click on the Security Incident Reporting Form link & download the incident 

reporting form. 
	 	 Step 4 Fill the relevant details in the form and send it to CERT-In.
	 	 ii. To report vulnerability to cert-in, follow these steps:
	 	 Step 1 Visit the website www.cert-in.org.in.
	 	 Step 2 Click on the Vulnerability Reporting link
	 	 Step 3 �Double-click on the Vulnerability Reporting Form link and download the vulnerability 

reporting form.
	 	 Step 4 Fill the relevant details in the form and send it to CERT-In.
D.	 1.	 Check for HTTPS and a digital lock icon in the browser bar.
	 2.	 Install updated antivirus and antispyware software.

SECTION C 
(Case-based/Passage-based Type Questions)

A.	 1.	 iii	 2. iii	 3. ii
B.	 1.	 ii	 2. iii	 3. ii
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Unit-3: Office Tools

	   Working with Word Processor

Lab Assignment ‘n Activity Page 124

Do it yourself.

Exercise

A.	 1.	 iii	 2. i	 3. i	 4. i	 5. i
	 6.	 ii
B. 	 1.	 .odt	 2. Clipboard	 3. Kerning	 4. Margin	 5. Bullet Marks
	 6.	 AutoSpellcheck		 7. Cell	 8. Merged
C.	 1.	 iv
	 2.	 i

SECTION B 
(Subjective Type Questions)

A.	 1.	 AutoSpellcheck		 2. Bullets option		  3. Page Number
	 4.	 Special Character	 5. AutoFormat		  6. Text Effects 
B.	 1.	 Format Paintbrush
	 2.	 To insert a table in a document, follow the given steps: 
	 	 Step 1: Position the insertion point where the table has to be inserted. 
	 	 Step 2: Click on Table drop-down button from the Standard toolbar. 
	 	 Step 3: �Click and hover the mouse pointer across the grid to select the desired number of 

columns and rows. 
	 	 Step 4: Click to insert the table into your document. The table will appear in the document.
	 3.	 0.5
	 4.	 To insert a symbol, follow these steps: 
	 	 Step 1: Place the cursor where the symbol has to be inserted. 
	 	 Step 2: �Select the Special Character option from the Insert menu. A dialog box titled Special 

Characters with various symbols appears on the screen. 
	 	 Step 3: Click on the required symbol. 
	 	 Step 4: Click on the OK button to insert the selected symbol.

3.
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	 5.	� Track changes feature in OpenOffice Writer helps a user to keep a record of formatting, text 
insertions, deletions and comments made by multiple editors.

C.	 1.	� A word processing package is an application software that helps type text and create 
documents. 

	 	 The important features of word processor that make it useful are: 
	 	 •  �Editing: In a word processor, editing of a document can be easily done without making the 

document messy. There is no need to retype the whole document while doing alterations. 
	 	 •  �Interface: A word processor provides layout i.e., interface which makes it convenient to 

type document without using paper or stationery. 
	 	 •  �Navigation between pages: A user can easily switch from one page to any other page of 

a document instantly in a word processor to view or to edit it. 
	 	 •  �Formatting: A word processor provides various options for formatting the text, for e.g., 

the user can change the look of the document by changing its font colour, size, style, 
appearance, etc. 

	 	 •  �Graphics: In a word processor, graphical pictures can be added in the document. Various 
tools to draw figures are also present in many word processors. 

	 	 •  �Spelling and Grammar: Word processor can detect the spelling and grammatical mistakes 
in a document and provide suggestions to rectify them.

	 2.	� Margin is the gap between the edge and beginning of text i.e., the outer boundary of the 
text in a document beyond which the contents of the document do not flow. There are four 
types: left margin, right margin, top margin, and bottom margin.

	 3.	� Header and Footer is the mark of identification or reference of the text which is displayed on 
every page of a document. Header or Footer contains information such as page numbers, 
date, logo of a company, title or file name of the document, etc.

	 	 To add Header or Footer, follow these steps: 
	 	 Step 1: Open the document in which you want to add a header. 
	 	 Step 2: Click on the Insert menu on the Menu bar. 
	 	 Step 3: Select the Header option from the drop-down menu. A submenu appears. 
	 	 Step 4: Select the Default option from the submenu for applying the header to pages. 
	 	 A cursor appears on the top of the page (for the header). 
	 	 Step 5: Type the text on it. In our case, we have typed ORANGE EDUCATION. 
	 	 Step 6: Click the mouse button outside the header area in the main document.
	 4.	� Line spacing is the vertical gap between different lines of text in a paragraph. It is measured 

in lines or in points. Types include Single, 1.5 lines, Double, At least, Proportional, Leading, 
and Fixed spacing.
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	 5.	 To insert date and time in OpenOffice Writer, follow the given steps: 
	 	 Step 1: Place the cursor where the current date and time has to be inserted. 
	 	 Step 2: Click on the Insert menu. 
	 	 Step 3: Select the Fields option. The Fields dialog box appears on the screen. 
	 	 Step 4: �Click on Date to insert the system date or click on Time to insert the system time in 

the document.
	 6.	� Merging combines two or more adjacent cells into one, while splitting divides a cell into 

multiple smaller cells.
	 	 To merge cells, follow these steps: 
	 	 Step 1: Select the adjacent cells that you want to merge. 
	 	 Step 2: Click on the Table menu on the menu bar. 
	 	 Step 3: Select the Merge Cells option from the drop-down menu.
	 	 To split the cells, follow these steps: 
	 	 Step 1: Place the cursor in the cell that you want to split. 
	 	 Step 2: Click on the Table menu on the menu bar. 
	 	 Step 3: �Select Split Cells from the drop-down menu. The Split Cells dialog box will appear 

on the screen.
	 	 Step 4: �For splitting the cell into the desired number of columns, specify how many cells the 

original cell should be split into in the Split cell into spin box. 
	 	 Step 5: �To split the cell into rows, select the Horizontally button under the Direction section. 

To split the cell into columns, select the Vertically button under the Direction section. 
	 	 Step 6: Click on the OK button.
	 7.	 To insert mathematical expressions, follow these steps: 
	 	 Step 1: �Select Object from the Insert menu and choose the option Formula from the submenu. 

Formula window appears on the screen. 
	 	 Step 2: Right click on the Edit window. 
	 	 Step 3: Select the desired formula type. 
	 	 Step 4: A submenu appears with several options. Select the desired expression say a>=b.
	 	 Step 5: �The expression will appear as <?> > <?> in the Edit window. Edit the given expression 

as per the need in Edit and Element window. 
	 	 Step 6: �After inserting the expression erase the right and left angular bracket and click 

anywhere in the document window to close the Edit window.
D.	 1.	 Formula option
	 2.	 Sonal should use the Line Spacing option. 
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SECTION C 
(Case-based/Passage-based Type Questions)

	 1.	 ii 	 2. ii	 3. iv

	   Working with Presentation

Lab Assignment ‘n Activity Page 155

Do it yourself.

Exercise

A.	 1.	 iii	 2. ii	 3. ii	 4. iv	 5. ii
B.	 1.	 Watermark	 2. Slide layout	 3. Slide Show	 4. Help	 5. Drawing
C.	 iii.

SECTION B 
(Subjective Type Questions)

A.	 1.	 Hatching	 2. Notes and Handouts	 3. Slide Sorter view
	 4.	 .odp	 5. Spelling
B.	 1.	 i. Title Slide		  ii. Title
	 2.	 To create a new presentation with an empty presentation: 
	 	 Step 1: Select Empty presentation from Presentation Wizard and click on the Next button. 
	 	 Step 2: Select a slide design from the Select a Slide design section. 
	 	 Step 3: Set the output medium under the Select an output medium section. 
	 	 Step 4: Click on Preview check box to see the preview. 
	 	 Step 5: Click on Create button.
	 3.	 To activate, click on Insert menu or press Alt+I keys.
	 4.	 OpenOffice Impress, MS PowerPoint, Adobe Director, 3-D Studio   
	 5.	 AutoSpellcheck tool automatically check the spelling mistakes in the text of a presentation.
C.	 1.	 To make a presentation with the help of Template, follow these steps:
	 	 Step 1: Click on From template.
	 	 Step 2: Click on Next button. 
	 	 Step 3: �Select a slide design for the presentation being created from Select a slide design 

section. 

4.
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	 	 Step 4: To see the preview, check the Preview button. 
	 	 Step 5: Select desired output medium from the Select an output medium section. 
	 	 Step 6: Click on the Next button.
	 	 Step 7: �Select Effect and Speed of slide transition and set the presentation type as (Default/

Automatic). 
	 	 Step 8: In case of Automatic enter the Duration of page and Duration of pause.
	 	 Step 9: Click on the Next button.
	 	 Step 10: A wizard screen asking for description of presentation appears on the screen.
	 	 Step 11: Enter basic details of presentation. 
	 	 Step 12: Click on the Next button. 
	 	 Step 13: Select the pages to be used in the presentation and click on the Create button.
	 2.	 i. �It is the basic layout or working area where the content of a slide is entered. It has five 

tabs: Normal, Outline, Notes, Handout and Slide Sorter.
	 	 ii. �It has options which perform basic operations related to editing or modifying the contents 

of a presentation.
	 	 iii. �Display Grid displays a grid on the slide to assist with precise alignment and object 

positioning.
	 	 iv. �Bullets and Numbering apply or modify bullet points or numbered lists in the selected 

text.
	 	 v. �Presentation Toolbar generally lies besides the standard toolbar to the right side of the 

screen.
	 3.	� A Placeholder is a box with a dotted boundary in a presentation that provides you with an 

area to add text/image/charts/graphics, etc., to a slide.
	 	 To enter text using placeholder, follow the given steps: 
	 	 Step 1: Click on the Click to add title to add a title. 
	 	 OR click on the Click to add text to add subtitle. 
	 	 Step 2: Type the text to add title/subtitle.
	 4.	 Bitmap is a predefined image used as background (e.g. water, marble)
	 	 To add a Bitmap image as background, follow the given steps:
	 	 Step 1: On the Background tab, select the Bitmap option from Fill drop-down box. 
	 	 Step 2: Choose the desired bitmap. 
	 	 Step 3: Click on OK button.
	 5.	� We can perform different types of operations on a slide like inserting header & footer, 

applying background, adding watermark, inserting page number, etc.
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	 	 •  �Header and Footer is the information of a page which is separated from the main body 
of the text and appears at the top and the bottom of the page.

	 	 •  �Watermark is a faded image of a design that is printed as a background that can be seen 
when held against light. In slides, it appears as a shadow.

D.	 1.	 Template
	 2.	 On-screen Presentation

SECTION C 
(Case-based/Passage-based Type Questions)

	 1.	 iv	 2. i	 3. iv

	   Effects in a Presentation

Lab Assignment ‘n Activity Page 172

Do it yourself.

Exercise

A.	 1.	 ii	 2. iii	 3. iv	 4. ii	 5. Iii
B.	 1.	 organised, interesting	 2. multimedia		  3. Ctrl, P
	 4.	 Insert		  5. Animation
C. 	 i.

SECTION B 
(Subjective Type Questions)

A.	 1.	 Slide Show	 2. Handouts	 3. Context menu	 4. Timing Bar	 5. Insert
B. 	 1.	� Handouts are thumbnails of all the slides printed together. By default, thumbnails of six 

slides are accommodated in a sheet of A4 size paper. 
	 2.	 Speaker Note allows you to add reference or notes for your help to the slides in a presentation.
	 3.	 Timing can be set using:
	 	 •  Setting time manually
	 	 •  Rehearse Timings
	 4.	� In Impress, different pictures and objects can be combined together to work and act as a 

single object. This process of combining the objects/pictures is known as Grouping.
	 5.	 Exit effects are used to make objects/text disappear from the slide with an animation.

5.
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C. 	 1.	� Custom animation feature enables to set timings between the display of the content or 
objects of the slides and also enables to apply different whirling effects to animate the 
object.

	 	� Slide Transition sets the style of appearance of slides in a presentation. It is the effect applied 
when a slide changes to another during on-screen presentation or slide show.

	 2.	� An electronic and digitalised way of delivering content or information is highly impressive 
specially while conducting a conference or giving lectures or demonstration and is commonly 
known as ‘presentation’.

	 	� Multimedia features: Inserted media, pictures, animations, sound, video, transitions, timings, 
etc.

	 3.	 To Print Handouts, follow the given steps: 
	 	 Step 1: Press Ctrl+P to print a presentation. 
	 	 Print dialog box appears on the screen. 
	 	 Step 2: Set the document as Handouts. 
	 	 Step 3: Set the number of slides to be printed per page. 
	 	 Step 4: Click on Print button.
	 4.	 To apply the transition effect, follow the given steps: 
	 	 Step 1: Select the slide to which the transition is desired. 
	 	 Step 2: Select the Slide Transition option from Slide Show menu. 
	 	 Step 3: Click on any of the transition effect from the Slide Transition task pane. 
	 	 Step 4: Set the speed of display (Slow, Medium, Fast) and sound effect.
	 	 Step 5: Repeat the above steps to apply such effects in other slides.
D.	 1.	 Rahul can use multimedia features.
	 2.	 Pooja should create and print handouts of the presentation.

SECTION C 
(Case-based/Passage-based Type Questions)

	 1.	 i	 2. iv	 3. i

	   Working with Spreadsheet

Lab Assignment ‘n Activity Page 202

Do it yourself.

6.
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Exercise

A.	 1.	 i	 2. iii	 3. iii	 4.  i	 5. iv
	 6.	 ii
B.	 1.	 1024	 2. Text Orientation 	 3. AutoFill	 4. fx
	 5.	 .ods
C. 	 1.	 i	 2. iv	 3. i	 4. iii 

SECTION B 
(Subjective Type Questions)

A. 	 1.	 10,48,576 rows
	 2.	� The selected or activated cell is referred to as the active cell which is always highlighted with 

a thick border.
	 3.	 Ctrl + S
	 4.	 Name box
	 5.	 Ctrl + Y
	 6.	 AutoFill
B.	 1.	To hide a sheet, follow these steps: 
	 	 Step 1: Select the sheet(s) to be hidden. 
	 	 Step 2: Select the option Sheet from the Format menu. Click on the Hide option.
	 	� The sheet with its sheet tab disappears, just as if the sheet was deleted but the sheet still 

remains in the spreadsheet.
	 2.	To add new sheets in the spreadsheet, follow these steps: 
	 	 Step 1: Right click on Sheet tab and select Insert Sheet option. Insert Sheet dialog box appears. 
	 	 Step 2: Set the Position where the new sheet is to be added in the spreadsheet. 
	 	 Step 3: Specify the number and the Name of sheet to be created.
	 	 Step 4: Click on the OK button. A new sheet will be added before the active sheet.
	 3.	�AutoFill is used to automatically fill a series of data (like months, numbers, or custom lists) 

in consecutive cells.
	 4.	Data can be classified into numeric, alphanumeric or text, date/time and formula.
	 5.	�Wrap Text ensures the content fits within the cell by increasing the row height, while Shrink 

to fit reduces the font size to fit the content within the cell.
C.	 1.	 •  �OR function produces true if any condition enclosed in bracket is true, otherwise it will 

produce false.
	 	 •  �AND function produces true if all the conditions enclosed in bracket is true otherwise it 

will display false.
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	 2.	 Operator is a symbol that performs certain mathematical or logical operations.
	 	 Types include:
	 	 •  Arithmetic Operators: +, -, *, /, % (for basic math operations)
	 	 •  Comparison Operators: =, >, <, >=, <=, <> (for comparing values)
	 	 •  Text Concatenation Operator: & (for combining text)
	 	 •  Reference Operator: : (used for referencing ranges)
	 3.	 To hide a column, follow these steps: 
	 	 Step 1: Select the column to be hidden. 
	 	 Step 2: Right click on the column header. 
	 	 Step 3: Select the option Hide.
	 4.	 i. �Formula Bar lies below the formatting toolbar. Formula that perform different calculations 

in cells are entered and displayed here. It is denoted by fx.
	 	 ii. �The numbers or values on which formulae are applied to perform mathematical operations 

are called operands.
	 	 iii. �It lies below the active sheet of the screen. The names of the sheets appear in the sheet 

tabs at the bottom of the spreadsheet. We can click on the specific sheet tab to open it.
	 	 iv. �Formatting a cell includes changing the contents of cell with respect to appearance i.e., 

changing Text, Styles, Alignment, Font, Font style, Font size, Border, Patterns, etc. of a 
cell or the contents of a cell.

D.	 1.	 Rohit should use the Wrap Text option.
	 2.	 Amandeep should use the AutoSum tool.

SECTION C 
(Case-based/Passage-based Type Questions)

A.	 1.	 i	 2. iii	 3. iii
B.	 1.	 Ii	 2. i	 3. iv

	   Data Analysis

Lab Assignment ‘n Activity Page 228

Do it yourself.

7.
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Exercise

A.	 1.	 iii	 2. iii	 3. iii	 4. iv	 5. ii
	 6.	 ii
B.	 1.	 Cell Reference	 2. Absolute	 3. Chart	 4. Sorting	 5. #REF!
C. 	 1.	 i	 2. ii

SECTION B 
(Subjective Type Questions)

A. 	 1.	 =A2 + A3	 2. =C4/(A3*A4)	 3. =MIN(B3:B7)	 4. =COUNT(D6:D30)
	 5.	 =5^4
B. 	 1.	 •  �OR function produces true if any condition enclosed in bracket is true, otherwise it will 

produce false.
	 	 •  �AND function produces true if all the conditions enclosed in bracket is true otherwise it 

will display false.
	 2.	 Operator is a symbol that performs certain mathematical or logical operations.
	 	 Types include:
	 	 •  Arithmetic Operators: +, -, *, /, % (for basic math operations)
	 	 •  Comparison Operators: =, >, <, >=, <=, <> (for comparing values)
	 	 •  Text Concatenation Operator: & (for combining text)
	 	 •  Reference Operator: : (used for referencing ranges)
	 3.	 i. #VALUE! occurs when a wrong type of argument or operand is used.
	 	 ii. #REF! occurs when the formula within the cell uses a reference that does not exist.
	 4.	 To hide a column, follow these steps: 
	 	 Step 1: Select the column to be hidden. 
	 	 Step 2: Right click on the column header.
	 	 Step 3: Select the option Hide.
	 5.	 i. Data series is the set of values which the user wants to plot in the chart.
	 	 ii. �In a 3-D chart, the base area or the plane in X-Y axis is called the floor and the vertical 

areas, i.e. planes in X-Z and Y-Z axis are called walls.
C.	 1.	� For doing calculations, formulas are used. Formulas can be applied on a large data set 

to perform various mathematical operations such as addition, subtraction, division, 
multiplication and many more.

	 	 A formula in a spreadsheet package may consist of the following:
	 	 •  Cell Address or a Cell Range 
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	 	 •  Functions 
	 	 •  Mathematical Operators 
	 	 •  Relational Operators 
	 	 •  Parenthesis 
	 	 •  Equal to operator 
	 2.	� The identification or address of a cell in a formula is known as a Cell Reference. There are 

three types of referencing in Calc: 
	 	 •  �Relative Referencing: It is based on the position of the cell in which the formula is typed 

with respect to the cell address of the formula.
	 	 •  �Absolute Referencing: It is applied when a user does not want to change the value while 

copying the formula with cell address to another cell.  
	 	 •  �Mixed Referencing: This type of cell referencing is the combination of absolute and relative 

referencing. While applying mixed referencing, either the row number or the column name 
of the cell address in the formula is fixed.

	 3.	 A function has two main parts: name and argument.
	 	� Name is the function that signifies the nature of operation. Argument specifies the values 

or the range of cells on which the specific operation is being applied and is always enclosed 
within the opening and closing parenthesis (i.e., Name refers to the operator and Argument 
refers to the operand).

	 4.	 Cell error Reasons
### Occurs when the cell contains a number, data or time that is wider 

than the cell width or when the cell contains a date and/or time 
formula that produces a negative result.

#VALUE! Occurs when a wrong type of argument or operand is used.
#NAME? Occurs when a function name is typed incorrectly, a named range 

is undefined, quotation marks for text are misused, or an undefined 
constant or function is used.

#NUM! Occurs when there is an invalid numeric operation, such as performing 
calculations on out-of-range numbers, taking the square root of a 
negative number, or dividing by zero. It can also happen if the result 
is too large or too small.

#REF! The formula within the cell uses a reference that does not exist. 
Either a column or row description name could not be resolved, or 
the column, row, or sheet that contains a referenced cell is missing.

#DIV/01 Occurs when a formula is divided by zero.
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	 5.	� A chart is a visual or graphical representation of data from a worksheet which is very useful 
for instant analysis and decision-making. There are various options related to charts that 
can be used to display data in Calc in a graphical format.

	 	 •  Line Chart: Line chart is used to view information that is shown by lines at equal intervals.
	 	 •  Column Chart: A column chart represents data over a period of time in columns.
	 	 •  Bar Chart: bar chart represents the data in horizontal bars.
	 	 •  �Pie Chart: A pie chart represents the data or value of each item in proportion or percentage 

to the consolidated or the sum value of all items.
	 	 •  �X-Y (Scatter) Chart: X-Y (Scatter) chart displays the relationships among the numeric values 

of several data series.
D.	 1.	 OpenOffice Calc
	 2.	� #### occurs when the cell contains a number, data or time that is wider than the cell width 

or when the cell contains a date and/or time formula that produces a negative result. 
	 3.	 =AVERAGE(B2:B7)

SECTION C 
(Case-based/Passage-based Type Questions)

	 1.	 ii	 2. iv	 3. i


